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Basic User Guide 
Key Features 

 

Rubex combines all of the document management features of eFileCabinet, the secure-sharing portal of 
SecureDrawer, and the power of document-process automation of Workflow in one tool. 

This guide covers: Basic Navigation, Creating Structure and Uploading Files, Creating and Managing 
Users, Templates, Workflows, and File Requests. 

Basic Navigation 
The Menu Bar options include: Main Menu, New, Share, Edit, More, Search, Help, and Activity Center. 
For all Menu Bar menus, available options will be shown in black while unavailable options will be 
grayed out. 

The Main Menu, represented by a hamburger icon, 
allows you to navigate Rubex. 
 
The Main Menu options include:  Home, Admin, 
Search, File Requests, Checked Out, My Settings, 
Workflows, and Logout. 
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The New Menu allows you to add Cabinets, Drawers, 
Folders, and Files. 

 
 

The Share Menu allows you to Share a cabinet, 
drawer, folder, or file with another person as well as  
Request Files, Download, or digitally sign documents 
with DocuSign or RightSignature.  

 
 

The Edit Menu allows you to Cut, Copy, Rename, or 
Delete a Cabinet, Drawer, Folder, or File. 

 
 

The More Menu, represented by an ellipsis icon, 
allows you to Apply a Template to a Drawer or Folder 
as well as to Mass Apply a Template to a Cabinet or 
Drawer. 

 
 

The Need Help button will open a window showing a 
list of interactive, step-by-step onscreen instructions 
for many common tasks. Under the Help tab, you can 
enter your question to find an appropriate tutorial or 
scroll manually to find your topic.  
 
The Tasks tab will give you the chance to try out the 
things you have learned from the tutorials to help 
you master Rubex.  
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The Search box allows you to Search for the name of 
a Cabinet, Drawer, Folder, or File, or information in 
Profile Items.  
 
The gear icon will open Advanced Search. 
 
 

 
 
 

 

The Help Menu, represented by a question mark, 
gives you access to various Help options. If you click 
on the Help in the menu, you will be taken to the 
eFileCabinet Support website. 

 
 

 

The Activity Center, represented by a task list, allows 
you to view the Upload Queue, which is a list of any 
Files that have been recently Uploaded to Rubex, and 
any Incomplete Uploads, which is a list of Files 
currently in the Upload process or Files that failed to 
Upload properly. 
 
It displays your personal Notifications, which may 
include notices of:  

• Something has been shared with you with 
any messages that were attached 

• An item is approaching its Governance date 
and will have an action applied  

• Workflow assignment 
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It additionally shows a list of your ‘Recents’, which 
can be Cabinets, Drawers, Folders, or Files. Clicking 
on any of these items will automatically navigate you 
to that location. 

 
 

There are several operations that are accessible by 
right clicking on an item’s name, either from the 
Cabinet or Tree View in the left pane or from the 
Contents View in the center pane. The menu will 
change based on what operations can be used on 
that type of item. 
 
Some of these operations include: New Drawer (or 
Cabinet or Folder), Upload, Quick Link, Add to 
Portfolio, Remove from Portfolio, ESignature, Apply 
Template, Mass Apply Template, Share, Check Out, 
Check In, Sign with eSignature, Request Files, Cut, 
Copy, Paste, Rename, Delete, Start Workflow, Make 
Searchable, Properties, and Preview. 
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In addition, there are several options when hovering 
over the name line of a Cabinet, Drawer, Folder, or 
File, including: Share, Upload, Cut, Copy, and Delete.  
. 

 

  
In Rubex, when an Account, Cabinet, Drawer, Folder, or File is selected, the Details Menu (the right 
pane) allows you to perform various actions, including: Details and Preview, Comments, Profile, 
Permissions, Governance, Automation, File Password, File Versions, and Audit Logs. 

Details and Preview on the Details Menu is 
represented by a lowercase letter i in a circle and an 
eye. The Details icon shows you information about 
the Account, Cabinet, Drawer, or Folder that you 
have selected. 
 
The Preview icon will appear when you select a File. 
Preview allows you to perform various actions on a 
File in the Preview pane.  

      

 

Comments on the Details Menu is represented by a 
conversation bubble. Comments allows you to view, 
add, or edit comments for an Account, Cabinet, 
Drawer, Folder, or File. 

 

Profile on the Details Menu is represented by a 
clipboard. A Profile can be added to an Account, 
Cabinet, Drawer, Folder, or File. Creating a Profile for 
items in Rubex increases your ability to find those 
items in a search because a Profile adds searchable 
metadata to the selected Cabinet, Drawer, Folder, or 
File. 
 
Note: If you add a profile to a drawer, for example, 
everything in that drawer will automatically inherit 
the profile and the entered metadata. 

 

 

Permissions on the Details Menu is represented by a 
person icon. Permissions can be added to an Account, 
Cabinet, Drawer, Folder, or File. Adding Permissions 
allows other users and groups to View, Edit, Delete, 
or Administer.  
 
The little number bubble shows the number of users 
that have access to the specific item. 
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Governance on the Details Menu is represented by a 
shield on a calendar. Governance settings can be 
added to an Account, Cabinet, Drawer, Folder, or File. 
Adding these settings for items in Rubex allows you 
to protect and retain the items for as long as 
necessary. Additionally, you can choose what should 
happen to those items at the end of its expiration. 

 

 

Automation on the Details Menu is represented by a 
bell, a gear with a chart, and gears, depending on the 
type of item you have selected.  
 
The bell represents automatic notifications you can 
receive when something happens in the place it is set 
on. You will receive an email and receive a 
notification in the Activity Center. 
 
The gear with the chart represents auto applying 
templates. If this is set up on a drawer, for example, 
any new folder that is created will automatically have 
the template applied. 
 
The gears represent beginning a Workflow 
automatically when a new folder or file is added. 

 

 

File Password on the Details Menu is represented by 
a key. File Password allows you to set a password to 
make the contents of a file even more secure. The 
Previewer will not show the file if a password is set, 
and the password is required in order to download or 
check out the file. 

 

 
 
Versions on the Details Menu is represented by two 
papers. Versions allows you to view the Versions 
information of a File, to upload a new Version of a 
File, and to set a previous Version of a File as the 
current Version. 

 

 

Audit Logs on the Details Menu is represented by a 
clock with a circle arrow. Audit Logs allow you to view 
information for a selected Account, Cabinet, Drawer, 
Folder, or File, which includes: Date and Time, User, 
Category, Action, IP Address, and any system notes. 
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Creating Structure and Uploading Files 
In Rubex, you need a container to store a file in, just like a physical piece of paper needs to go into a 
folder or drawer of a filing cabinet. Cabinets allow documents to be organized according to categories or 
departments, just as with a physical filing cabinet. Cabinets may contain many Drawers, and each 
Drawer may contain multiple Folders, Subfolders, and Files.  

 

To add a Cabinet, select the Home tab from the 
Cabinet View.  
 
Make sure that an Account is the active item and 
shown in the Active Item Bar. 
 
Note:  Cabinets can only be created by Administrators 
and added to Accounts. 

 
 

Select Add Cabinet from the New menu. 

 
 

A New Cabinet will appear in the Contents View (the 
center pane). It will be named New Cabinet. Change 
the name of the New Cabinet by typing a name in the 
New Cabinet name box. Press Enter, select the disk 
icon or use your mouse to click your cursor outside 
the New Cabinet name box. 

 

 

The process to create a Drawer and a Folder using the 
New menu is very similar to creating a Cabinet. The 
difference is that you need to have a Cabinet selected 
to add a Drawer or a Drawer or Folder selected to 
add a Folder. 
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Another way to add a Drawer or a Folder is to right-
click on the applicable selected item and select New 
Drawer (or New Folder) from the menu.  

 
 

Finally, in the Cabinet View (left pane), hover over the 
Cabinet that needs a Drawer or the Drawer that 
needs a Folder.  
 
To add a Drawer, click on the add Drawer icon that 
appears to the right of the Cabinet name. This will be 
represented by a Drawer with a plus sign. 
 
To add a Folder, click on the add Folder icon that 
appears to the right of the Drawer (or other Folder) 
name. This will be represented by a Folder with a plus 
sign. 
 

 
 

 

Files can be stored in Drawers and Folders. In Cabinet 
View or Contents View, select the Drawer or Folder 
that needs a File.  

 
 

Click on New and select Add File from the menu. 
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Alternatively, right-click and select Upload from the 
menu. 

 
Additionally, in the Cabinet View or Contents View, 
hover over the Drawer or Folder that needs a File. 
Click on the Upload File icon that appears to the right 
of the Drawer or Folder name. This will be 
represented by a computer drive with an upward 
arrow.  
 
Similarly, at the bottom of the Contents View, click on 
Drag or Click Here. 

 

 
 
 

 
 

After using one of these options, a File Upload screen 
will appear to allow you to search for specific Files. 
 
To add a single File to a Drawer or Folder, select the 
File you want to add. 
 
Click Open. 

 
 

To add multiple Files to a Drawer or Folder, select the 
multiple Files you want to add by Ctrl clicking or Shift 
clicking on the File names. 
 
Click Open. 
 
The File or Files will be added to the selected Drawer 
or Folder. 

 
 



Rubex Basics User Guide - 10 
 

Finally, you can add a File to a Drawer or Folder by 
dragging the File from your desktop and dropping it 
into the Drawer or Folder where the File should be 
stored. From either the Cabinet View or the Contents 
View, select the Drawer or Folder that needs a File. 
 
Use your mouse to drag the File to the bottom of the 
Contents View (center pane) to the Drag or Click 
Here space. 
 
Tip: You can also create Folders by dragging a folder 
from your computer to the same space. 
 

 

Creating and Managing Users 
The Account Owner is also known as the administrator. This user has full access to Rubex. There are also 
Standard Users and Guest Users. Standard Users are typically people who work for the same company 
as the Account Owner and require a User License. Guest Users are typically people who work elsewhere 
but need the ability to share data with the company of the Account Owner.  

To access your users, click on the Main Menu 
(hamburger icon), then Admin, and finally Users and 
Groups. 
 
From this menu, you can add or edit existing Users, 
Guests, and Groups as well as manage your licenses 
for all types of users. 

 
 

When you select the Users, you will see a list of Users 
and a Create User option.  
 
Click on Create User to create a new user.  
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For a new user, enter a valid email address for the 
Login. This will be the username that is used to log in 
to Rubex.  
 
The Display Name will be shown throughout Rubex 
for that user rather than using the email address. 
 
Like your files and structure items, you can assign a 
Profile to your users to store metadata information, 
e.g. phone number, birthday, department, job title. 
 
Security Policies are rules that can be created to add 
an additional level of security to your data by limiting 
the times of the day and/or only allowing access from 
specific IP addresses. This is where you would apply 
that policy to a new user. 
 
System Permissions are critical to set up. This 
determines what actions and abilities your user will 
have in your system. 

 

 

User Licenses is a quick way to assign licenses to your 
user. You simply click on the check box next to the 
license that you want to assign. Please note that the 
items listed, such as Sidekick, will not work for that 
user without an assigned license. 
 
Groups are an easy way to streamline your 
permissions. It is much easier and more efficient for 
your business to apply group permissions to your 
data than it is to manage individual users. It is highly 
recommended to control permissions by adding and 
removing users from groups. 
 

 

 
From the Users Menu, you can delete a user or have 
a password reset email sent to a user by hovering 
over the applicable user and clicking on the trash can 
or envelope icon. 
 
In Rubex, all passwords are handled by the system. If 
any user forgets his or her password, he or she may 
request a password reset email or one may be 
requested for them. However, the password cannot 
be manually reset. 

 

 

To edit a user, click on the Username of the person 
you wish to edit from the Users menu. This will allow  
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you to change any of the settings that are available 
when creating a new user. 

 
 

The Groups Menu shows a list of all of your groups. 
You can edit a group by clicking on the name, or 
create a new group by clicking on Create Group. 
 
To delete a group, hover over the applicable group 
and click on the trash can icon. 

 

 
 

When creating or editing a group, you can add 
permissions or apply security policies for members of 
the group. Additionally, you can add members to the 
group. 
 
Click on drop down arrow and find the applicable 
user. Select the user. Click on the person with a plus 
sign icon to add the user to the group. Click the blue 
Save Group icon at the bottom of the page. 

 
 
 
 
The User Licenses menu allows you to quickly see 
what licenses are available on your account and to 
see which users have licenses assigned. 
 
To assign a license, click on the applicable empty 
checkbox. To un-assign a license, click on the checked 
checkbox. 

 

 

 

Templates 
Templates are a powerful tool to help standardize your filing practices and to ensure that every 
customer or project has all of the required documentation for you to do your business well. A template 
can be applied to a Drawer or a Folder that may include pre-named folders, pre-defined names to use 
on newly stored documents, or files. Additionally, you can apply a profile, permissions, governance, and 
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automation for items in a template. You can manually apply a template, have a template applied as part 
of a Workflow, or automate it to be applied to a new Drawer inside a specific Cabinet.  

 
Individual templates are arranged in Template 
Libraries. This allows templates to be organized into 
similar types.  
 
To access your Templates, click on the Main Menu 
(hamburger icon), then Admin, and finally Templates. 
 

 

 
 
From this menu, you can add or edit existing 
Template Libraries. Template Libraries are identified 
by the government building icon. 
 
Click on Create Template Library to make a new 
library or click on the name of the desired Template 
Library to add Templates. 
 

 

 

Templates are represented by an organization chart 
icon. Click on Create Template to add a template to 
this Library or click on the name of an existing 
Template to edit it. 

 

 
 

Start building your template by hovering over the 
template name and clicking on the Add Folder icon or 
by right clicking on the name to view a full list of 
options. 

 
 

Each item type will have a unique right-click menu 
and icons with the Template options that are 
available at each level. 
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This sample template called “New Employees” will 
add a document called “Background Check”, a folder 
called “Financial Info” that has a pre-defined name of 
“Direct Deposit” inside it, and a folder called “Health 
Forms” with a sub-folder called “Dependent Info”. 
 
Items can be renamed or deleted by right-clicking and 
selecting the applicable command. 

 
 

Each item in your Template will have information and 
more options listed in the Details View, the right 
pane. As seen in the Basic Navigation section of this 
guide, the Details Menu allows you to add a profile, 
permissions, governance, and automation to that 
item in your template. 
 

 
 

As your Templates evolve, you can add, rename, or 
delete items to a Template. When you click the blue 
Sync Changes button at the bottom of the screen, 
any changes you make in the Edit Template section 
will then be automatically mimicked throughout your 
system wherever that Template has been applied. 

 

 
 
You can apply or mass apply a template from the 
More menu or from the right-click menu. 
 
Templates can also be applied as part of a Workflow. 

 

 
 

Workflows 
All organizations have processes of some kind. Workflows allow you to take a standard process, break it 
down into steps, and then automate those steps as much as possible. You can make simple, straight 
forward Workflows or very complex Workflows that incorporate profile routing, multiple approval steps, 
and automating almost every feature that is available in Rubex. 
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To access the Workflow Menu, click on the Main 
Menu (hamburger icon), then Admin, and finally 
Workflows. 
 
From this menu, you can manage Workflows, view or 
launch Workflow instances, view the Dashboard, or 
check the History if you have the Manage Workflow 
permission. Without this permission, you will only see 
Instances. 
 
 
 

 

 
The Workflows section will bring up a list of existing 
Workflows (processes) that you can edit or you can 
create a new Workflow.  
 
Click on Create Workflow. 
 
 

 

 

Begin by filling in the top header information, 
including the Workflow Name and Description. Both 
of those items are displayed on the main Workflow 
page.  
 
You can click on Workflow Settings, or the gear icon, 
to access advanced configuration settings. These 
include notification settings, instance naming, and 
other default settings. 
 
The Workflow Preview, indicated by the eye icon, will 
map out the stages in your process in a diagram.  
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Workflows consist of stages, which are comprised of 
one or more steps. The stages in a Workflow are 
shown on the left of the center pane. Each stage 
should contain steps or tasks that are need to be 
completed by one person or group. 
 
Begin by adding a Title.  
 
Next, use the Available Assignees dropdown list to 
select the user or groups to assign the Workflow 
tasks to.  In the Default Assignee, you can select a 
specific individual that will receive the assignments 
first. 
 
You have additional options, such as Timeframe, 
Approvers, and specifying what happens at the end of 
this stage. 
 
  

 
 
 
 
 
 
 
 
Click the check box next to Timeframe to add a time 
requirement for the completion of all of the steps. Fill 
in the appropriate days, hours, and minutes for the 
entire stage. 
 
You also select what happens if the time expires. You 
can select: Do Nothing, Next Stage, Repeat Stage, Go 
To… (another step in the Workflow), or Finish 
Workflow. 
 

 

 
 
 

You can also require another user to approve or 
reject the Workflow stage after all of the steps have 
been completed by the assigned users. When you 
click the check box, it will bring up a dropdown list for 
you to select the user or group to be the approvers.  
 
If you want more than one person to approve the 
stage, change the number in “Must Approve” to be 
the number of approvals that are required before the 
Workflow may advance to the next stage. 
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You may specify a default message that will come 
from the assigned person and go to the approvers. 
 
If the approver rejects the stage, specify what should 
happen in the last dropdown list. This includes: Next 
Stage, Repeat Stage, Go To…, and Finish Workflow. 
 

 
 

The last setting to select for the Stage set up is what 
happens when the current stage is Approved. If 
approvers are not involved, you select what happens 
when the stage is Completed. You may select Next 
Stage, Repeat Stage, Go To…, Finish Workflow, or 
Profile Routing. 
 
Profile Routing allows Rubex to send the Workflow to 
different paths based on specific profile values that 
are entered. For example, if you have a Workflow for 
new hire applications, you could use profile routing 
to have the resume sent to the hiring manager for a 
specific department automatically. 
 

 

 

 

After the details of your stage are set up, next add 
the steps or the specific tasks that need to be 
completed before moving on to the next stage or 
completing the Workflow. 
 
The steps are shown in the right side of the center 
pane. From the large list of options, all of the actions 
you can do manually in Rubex can be incorporated 
into a Workflow to automate and simplify your work 
processes. 
 
These actions include: Copy, Delete, Move, Create 
Location, Upload, Share, Set Permissions, Apply 
Template, Set Profile, Send Message, Comment, Set 
Governance, Rename, and Request File. 
 
Select the step you want to add by clicking on it. 
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In this example, we chose “Create Location”. Each 
step will bring up the applicable options. Explore the 
dropdown lists.  
 
Instructional words that are shown in blue (in this 
example, “Select parent path”), require more 
information from you. In this case, click on the words 
and navigate to the parent location of where you 
want your new location to be stored.  
 
If you fail to provide the information, additional help 
text in orange will appear. 
 
 

 

Once you have provided the necessary information 
for your step, you may click the Add Step link to add a 
new step, you can create new stage by clicking on 
Create Stage at the very top of the pane, Save, Save 
As, or Cancel. 
 
Tip: It is highly recommended to click the blue Save 
button regularly to avoid losing progress you have 
made creating your Workflows.  

 
 

 

When you have more than one step, you may re-
arrange the steps if needed by clicking on the up 
arrow to move it ahead in the order or the down 
arrow to move it back.  
 
You may also delete a step by clicking on the trash 
can icon. 
 
There is no limit to the number of steps that you may 
have in a single stage or Workflow. 
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When all of your stages and steps have been created 
and saved, you will see an overview of stages you 
created. The steps are notated by icons that 
represent the actions involved.  

 

 
Clicking the eye icon will show you a graphical 
representation of the stages and steps you created. 
This helps to visualize the routing and the steps. This 
is particularly helpful with complex Workflows. 

 
 
 

 
 

 
When working with Workflow steps, cabinets, 
drawer, folders, and files are referred to as Assets. 
You can create Assets before setting up the steps by 
clicking on the Add link in the far right pane. This will 
open the screen to create an asset. 
 
Alternatively, you can select the Workflow step you 
want and follow the prompts and requirements for 
that step.  
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There are three asset types: Files, Path, and Manual. 
To create a File Asset, select the Files tab. 
 
Navigate through your data shown in the left hand 
pane to find the stored file you want to use in a 
Workflow.  
 
The arrows will expand or collapse a level. The 
contents of the item will be shown in the center 
pane. When you click on your file, the file name will 
automatically be put in the Asset Name box. You can 
change it if you want.  
 
Click the blue Done button to save your file asset. 

 
 

 

 
To create a Path Asset, select the Path tab. 
 
Navigate through your data shown in the left hand 
pane to find cabinet, drawer, or folder that you want 
to use in a Workflow. 
 
The arrows will expand or collapse a level. When you 
click on your desired location, the name will 
automatically be put in the Asset Name box. You can 
change it if you want.  
 
Click the blue Done button to save your path asset. 

 

 
 

To create a Manual Asset, select the Manual tab. 
Manual assets refer to items that are created during 
the Workflow process since they do not already exist 
in your data like the other two types of Assets. You 
can choose a Single File, Multiple Files, or a Path.  
 
The Single File or Multiple Files option will require the 
user to upload a file or files. You can include “Allowed 
file extensions” to ensure the data integrity of the 
new file or files.  
 
The Path will require the user to manually navigate to 
the location in your data that will be impacted by the 
associated Workflow. 
 
Enter a name in the Asset Name.  
 
Click the blue Done button to save your manual asset. 
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Your list of created Assets will be shown in the right 
hand pane. 

 

 
 
 

  

Once your Workflows have been created, you can 
launch “Instances”. This allows the same Workflow to 
be used at the same time for different reasons. In the 
example we have been using of receiving a new 
application for an open job position, you would 
launch 3 separate instances if you had 3 applicants. 
 
You can create a Workflow Instance by hovering over 
the Workflow name from the Workflow tab and 
choosing “Create Instance”, clicking on “Create 
Workflow Instance” from the Instances tab, or 
clicking on Automation from the Details View and 
selecting Start Workflow from the Actions dropdown 
list. 

 

 

 
 

After you launch an instance, you will be asked to 
choose which Workflow you want. 
 
Next you will see the description and the stages for 
the selected Workflow. At this point, you can change 
whom to assign stages to if there are multiple people 
or change the instance name if it is not configured to 
auto-populate a name. 
 
Click the blue Create icon to send the first Workflow 
notification.  
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The user who is assigned to the first Stage will receive 
a Notification in the Activity Center as well as an 
email to inform him or her that a Workflow has been 
assigned to him or her. 
 
Clicking on the email link or the link in the Activity 
Center will take the user directly to the Workflow to 
be worked on. 

 

 

All of the steps for this stage are listed. The yellow 
“To Do” helps the user to know which steps still need 
to be done. Completed steps are noted by the green 
“Complete”. 
 
The right pane shows the visual flow of where the 
stage is in relation to the overall Workflow. 
 
Once all of the steps have been completed, the 
Workflow will advance automatically.  

 
 
 
The Instances section of the Workflow menu will 
show you a list of all of the Workflow Instances that 
have been created, as well as the current status. It 
shows who the owner is, what stage it is on, whom it 
is currently assigned to, and its completion status. 
 
Click on an individual instance to complete the steps 
if it is assigned to you, or to see more details of 
where it is at in the Workflow process. 

 
 
 

 

The Dashboard section of the Workflows menu is a 
valuable tool for administrators or supervisors to see 
how many Workflow Instances are being completed. 
It may provide insight into the workload of his or her 
employees by seeing how many instances are 
currently active for each employee.  
 
This graph shows the number of instances that have 
been completed in the timeframe shown in the 
dropdown box. The default is Today, but can be 
changed to Last 5 Days, Last 7 Days, and Last Month. 

 

 

 

The Current Snapshot graph shows the number of 
active instances grouped by the assigned user. If you 
hover over the section, it will give you the exact 
number. 
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The Workflows Table shows the total number of 
instances for each Workflow type and lists the 
number of instances that are In Progress and 
Awaiting Approval.  

 

The Time Spent chart shows how much time each 
user has spent on Workflow instances that are 
currently active, Started in the Past Week, and 
Started in the Last Month. 
 
Hovering over the specific chart sections will give you 
the actual time spent. 
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The History section of the Workflow Menu shows the 
audit logs for everything related to Workflows, both 
the creating and editing Workflows as well as 
Instances. 
 
Filter the results by filling out the criteria boxes along 
the top of the pane. 

 
 

File Requests 
Rubex allows you to request a specific file from another user. As part of the File Request process, you 
identify where you want the file to be stored, if there is a timeframe involved, and provide a 
personalized message.  

To access the File Requests, click on the Main Menu 
button and then File Requests. 
 
From the File Requests menu, you can see your active 
requests, all file requests that have been done on 
your account, File Request Templates, and request 
files. 
 
To request a file, click Request Files from this menu, 
right-click on the drawer or folder where the file will 
be stored, or click on the Share menu.  

 

If you used the Right-Click menu or the Share menu, 
the Destination field will be automatically filled in 
based on the active item when you selected File 
Request. If you are doing a generic New Request, click 
on the blue Select button to choose the location. 
 
In the To box, you need to select the recipient for 
your file request. All of your existing users will be 
available from the dropdown list. You do have the 
option to manually enter in the email address for a 
person. If that person is not already in your Rubex 
account, that email address will be used to 
automatically create a guest user. 
 
Enter a Subject, any Attachments, and a Message. 
 
Click on the checkbox next to Timeframe to include a 
desired response time. 
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The Files to Request section is where you enter the 
specific file information that you want the user to 
send back to you. The default example is requesting 
this user’s 201 W-2 Tax Form. 
 
If you want to request more than one form or file, 
click on Add in the second pane and enter the 
applicable information. 
 
Click the blue Save Template button to make this file 
request available for later use. 
 
Click the blue Send button to send your request. 

 

 
 
 
If you need to select the path, the Select Destination 
screen will come up after pressing the blue Select 
button. Navigate through your data shown in the left 
hand pane to find the desired drawer or folder. 
 
The arrows will expand or collapse a level. When you 
click on your desired location, click the blue Select 
button. 
 
 
 

 
 

 
 
  

Your My Requests Inbox will show you any requests 
that you need to complete. 
 
Drag to or Click on the blue box with your requested 
file. Click on the blue Submit button. 
 
If the requester left “Notify on Completion” checked, 
he or she will receive an email and a notice in the 
Activity Center once you have submitted your item. 
 

 
 

 
Your My Request Sent folder shows all of the file 
requests that you have sent. You may click on an 
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individual request to make changes even after it has 
been sent. 

 

Account Requests shows all file requests that have 
been made by any user on your account. 

 
 
  

 
 
File Request Templates show a list of any file requests 
that you saved as a template. It also allows you to see 
a preview of what the request will look like to the 
user. 

 

 
 


